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Avant-propos 

L'ISO (Organisation internationale de normalisation) est une fédération mondiale d'organismes nationaux de 
normalisation (comités membres de l'ISO). L'élaboration des Normes internationales est en général confiée 
aux comités techniques de l'ISO. Chaque comité membre intéressé par une étude a le droit de faire partie du 
comité technique créé à cet effet. Les organisations internationales, gouvernementales et non 
gouvernementales, en liaison avec l'ISO participent également aux travaux. L'ISO collabore étroitement avec 
la Commission électrotechnique internationale (CEI) en ce qui concerne la normalisation électrotechnique. 

Les Normes internationales sont rédigées conformément aux règles données dans les Directives ISO/CEI, 
Partie 2. 

La tâche principale des comités techniques est d'élaborer les Normes internationales. Les projets de Normes 
internationales adoptés par les comités techniques sont soumis aux comités membres pour vote. Leur 
publication comme Normes internationales requiert l'approbation de 75 % au moins des comités membres 
votants. 

L'attention est appelée sur le fait que certains des éléments du présent document peuvent faire l'objet de 
droits de propriété intellectuelle ou de droits analogues. L'ISO ne saurait être tenue pour responsable de ne 
pas avoir identifié de tels droits de propriété et averti de leur existence. 

L'ISO 19440 a été élaborée par le comité technique CEN/TC 310, Technologies d'automatisation avancée et 
leurs applications du comité européen de normalisation (CEN), en collaboration avec le comité technique 
ISO/TC 184, Systèmes d'automatisation et intégration, sous-comité SC 5, Architecture, communications et 
structures d'intégration, conformément à l'accord de coopération technique entre l'ISO et le CEN (Accord de 
Vienne). 
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Introduction 

0.1 Fondement 

La présente Norme internationale définit les concepts génériques requis afin de rendre possible la création de 
modèles d'entreprise pour les activités industrielles et pour fournir l'assistance à l'utilisation de cadres de 
modélisation aux entreprises industrielles. La présente Norme internationale bâtie sur l'ISO 19439 définit et 
détaille un ensemble de constructs pour langage de modélisation orienté utilisateurs, conformes à cette 
dernière; cet ensemble fournissant alors une sémantique commune et permettant l'unification de modèles 
développés par différentes parties prenantes dans les différentes phases du développement de modèles. De 
tels modèles sont appropriés à l'assistance à la prise de décision opérationnelle basée sur la modélisation et 
peuvent être employés pour le contrôle et la surveillance des opérations également basés sur la modélisation. 

Les constructs pour langage de modélisation définis dans la présente Norme internationale peuvent être 
spécialisés et/ou organisés dans des structures adaptées à des objectifs particuliers, par exemple pour un 
secteur industriel ou un type de préoccupation de l'entreprise tel que la maintenance. À leur tour, ces 
structures et ces constructions pour langage de modélisation générique peuvent être utilisés pour développer 
des modèles spécifiques pour une entreprise particulière. L'Annexe B contient des compléments sur le 
fondement ainsi que la justification et l'exposé des avantages de la présente Norme internationale. 

Les exigences générales qui déterminent les caractéristiques du noyau de constructs nécessaires à la 
modélisation d'entreprise assistée par ordinateur, sont 

⎯ la fourniture d'un modèle explicite de «Business Processes» avec leurs dynamiques, leurs fonctions, leur 
information, leurs ressources, leur organisation et leurs responsabilités, 

⎯ un niveau de qualification et de détail des composants de l'entreprise, suffisant pour autoriser la création 
d'un modèle pour une entreprise spécifique, 

⎯ l'assistance à la gestion des changements, et 

⎯ une représentation orientée utilisateur pour rendre possible une utilisation opérationnelle. 

Dans l'Annexe E, un exemple illustre l'utilisation des constructs pour langage de modélisation. 

L'Annexe B fournit la justification de la modélisation d'entreprise basée sur des constructs et fixe le fondement 
de la présente Norme internationale ainsi que le cadre pour la modélisation d'entreprise sur lequel elle est 
basée (voir l'ISO 19349). Les trois dimensions de ce cadre sont décrites en 0.2, 0.3 et 0.4. 

Les contributions à la présente Norme internationale ont été reçues des membres du groupe de travail de 
l'IFAC/IFIP sur l'entreprise intégrée, du consortium CIMOSA et du projet de recherche européen ATHENA. 

NOTE Les Figures C.1 à C.6, D.1 à D.3 et D.5 à D.12 sont générées par ordinateur. Les Figures D.4 et E.1 à E.5 
sont des dessins au trait. 
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0.2 Dimension des vues pour modèle d'entreprise 

L'ISO 19439 et l'ISO 15704 utilisent des vues de modèle d'entreprise (souvent raccourcies en «vue de 
modèle») pour fournir une perception sélective d'une Entreprise qui accentue certains aspects particuliers du 
sujet considéré et néglige les autres. Elles identifient spécifiquement quatre vues de modèle d'entreprise 
(Fonction, Information, Ressource, Organisation) qui doivent être prises en compte dans un cadre de 
modélisation, une architecture ou une méthodologie pour permettre la modélisation des aspects essentiels 
d'une entreprise. De plus, comme spécifié dans l'ISO 15704:2000, A.3.1.5.3.2, «d'autres ... vues peuvent, si 
nécessaire, être définies ... et bénéficier du support d'outils d'ingénierie», par exemple des vue économiques, 
des vues décisions, des vues perspective, des vues implémentation. Dans ce cas, les constructs définis dans 
la présente Norme internationale peuvent être enrichis par des attributs additionnels pour appuyer ces autres 
vues mais on peut aussi être amené à définir de nouveaux constructs qui leur sont appropriés. Par 
conséquent, les spécifications de constructs pour langage de modélisation doivent prendre en compte leur 
utilisation escomptée et leur représentation dans une ou plusieurs vues particulières pour modèle. Des outils 
automatisés sont nécessaires pour s'assurer de la cohérence des instances de constructs lorsqu'ils peuvent 
apparaître dans plus d'une vue. 

0.3 Dimension de la phase d'un modèle d'entreprise 

Le cycle de vie de modèles et de composants de modèles est traité dans l'ISO 19439 par la dimension de la 
phase d'un modèle d'entreprise. Cette dimension concerne le développement et l'évolution du modèle du 
domaine à modéliser, depuis l'identification du domaine d'entreprise en passant par le modèle traitable par 
ordinateur et jusqu'à son déclassement. En conséquence, les spécifications de constructs pour langage de 
modélisation doivent prendre en compte leur utilisation escomptée et leur représentation dans une phase de 
modèle particulière. Les attributs des constructs pour langage de modélisation doivent être adaptables et 
sélectionnables pour des phases de modélisation différentes de manière appropriée aux besoins prévus. 

0.4 Dimension de généricité 

Pour ce qui concerne la dimension de généricité définie dans l'ISO 19439, les constructs se situent au niveau 
générique et peuvent être utilisés aux niveaux partiels et particuliers. Au niveau partiel, certaines valeurs 
d'attributs peuvent rester non définies pour des instances au niveau partiel (par exemple des entrées/sorties 
pour des événements de domaines et des entrées/sorties pour des «Business Processes»). De telles entrées 
manquantes doivent être complétées au niveau particulier. 
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Entreprise intégrée — Constructions pour la modélisation 
d'entreprise 

1 Domaine d'application 

La présente Norme internationale spécifie les caractéristiques du noyau de constructs nécessaires pour la 
modélisation d'entreprise assistée par ordinateur en conformité avec l'ISO 19439. 

La présente Norme internationale privilégie, mais ne se limite pas à l'intégration par ordinateur de l'aspect 
informationnel de la fabrication, y compris la gestion et le contrôle technologique et les tâches humaines. Elle 
ne spécifie pas la manière dont ce noyau de constructs destinés à des opérations basées sur des modèles, 
doivent être mis en place et, en particulier, elle n'inclut pas le langage de contrôle nécessaire pour spécifier et 
concrétiser un comportement (interne) d'activité, ni la mise en correspondance entre opérations fonctionnelles 
et aptitudes. 

NOTE La modélisation d'entreprises assistée par ordinateur peut constituer une première étape vers l'intégration 
informatique ou être utilisée comme intermédiaire entre les hommes et le système. 

2 Références normatives 

Les documents de référence suivants sont indispensables pour l'application du présent document. Pour les 
références datées, seule l'édition citée s'applique. Pour les références non datées, la dernière édition du 
document de référence s'applique (y compris les éventuels amendements). 

ISO/CEI 14977, Technologies de l'information — Métalangage syntaxique — BNF étendu1) 

ISO 19439:2006, Entreprise intégrée — Cadre de modélisation d'entreprise 

3 Termes, définitions et abréviations 

Pour les besoins du présent document, les termes et définitions suivants s'appliquent. Les termes définis 
dans l'ISO/CEI 15288:2002, l'ISO 15531-1:2004, l'ISO 15704:2000 et l'ISO 19439:2006, utilisés dans la 
présente Norme internationale sont répétés ci-dessous par commodité. 

NOTE Les noms des termes représentant des constructs sont écrits avec une lettre initiale en majuscule tout au long 
de la présente Norme internationale pour aider le lecteur à les distinguer de l'usage général des mêmes termes, en 
particulier pour distinguer les constructs «Capability» (Aptitude), «Domain» (Domaine), «Enterprise Activity» (Activité 
d'entreprise), «Event» (Événement) et «Resource» (Ressource) de l'utilisation générale d'aptitude, domaine (ou domaine 
d'entreprise), activité d'entreprise, événement et ressource. Ces constructs sont définis en 3.1 et spécifiés dans l'Article 6. 

                                                      

1) L’ISO/CEI 14977 est une Norme internationale librement accessible qui peut être téléchargée gratuitement à l’adresse 
suivante: http://isotc.iso.org/livelink/livelink/fetch/2000/2489/Ittf_Home/PubliclyAvailableStandards.htm 
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3.1 Termes et définitions 

3.1.1 
agrégation 
processus ou résultat de combinaison de constructs pour langage de modélisation et d'autres composants de 
modèle en une entité globale 

NOTE 1 Les constructs pour langage de modélisation et les autres composants de modèles peuvent être agrégés en 
plus d'une entité. 

NOTE 2 Les attributs «Part_of» (Élément_de) et «Consists_of» (Consiste_en) sont tous les deux utilisés dans la 
relation d'agrégation décrite dans l'Article 5. 

[ISO 19439:2006] 

3.1.2 
attribut 
élément d'information énonçant une propriété d'une entité 

[ISO 15704:2000] 

3.1.3 
règle comportementale 
description des relations logiques de séquencement des activités constituantes d'un «Business Process» 
utilisée dans la spécification de son comportement 

3.1.4 
«Business Process» (Processus Métier) 
〈modélisation d'entreprise〉 construct qui représente un ensemble partiellement ordonné de «Business 
Processes» ou «Enterprise Activities» ou les deux, pouvant être exécuté pour réaliser un ou plusieurs 
objectifs donnés d'une entreprise ou d'une partie de celle-ci afin d'atteindre un résultat escompté 

3.1.5 
aptitude 
〈généralité〉 qualité d'être capable d'accomplir une activité donnée 

[ISO 15531-1:2004] 

3.1.6 
«Capability» (Aptitude) 
〈modélisation d'entreprise〉 construct qui représente la collection des caractéristiques d'aptitude (exprimées 
comme des attributs d'aptitude) soit d'une Ressource (son Aptitude proposée) soit d'une «Enterprise Activity» 
(son Aptitude demandée) 

NOTE Les Aptitudes peuvent être agrégées. 

3.1.7 
classe 
abstraction représentant et encapsulant des propriétés, des relations et des comportements, l'ensemble 
différenciant ainsi une collection de phénomènes similaires 

NOTE La classe est utilisée dans un sens très général sans aucune connotation relative à une implémentation ou 
une utilisation liée à une méthodologie particulière. 

3.1.8 
classification 
processus d'arrangement d'abstractions en une structure organisée par rapport aux propriétés, relations et 
comportements qui les distinguent 
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3.1.9 
composant 
〈généralité〉 entité qui fait partie de, ou capable de devenir une partie d'un tout plus large 

NOTE Adapté de l'ISO 19439:2006. 

3.1.10 
composant 
〈système〉 entité avec une structure discrète à l'intérieur d'un système, qui interagit avec d'autres composants 
du système, contribuant ainsi aux propriétés et aux caractéristiques de ce système 

NOTE Adapté de l'ISO/CEI 15288:2002. 

3.1.11 
définition de concepts 
phase d'un modèle d'entreprise définissant dans un domaine d'entreprise les concepts métiers à employer 
dans la réalisation des objectifs métiers et dans l'exploitation de celui-ci, y compris les entrées et sorties qui 
lui sont nécessaires 

[ISO 19439:2006] 

3.1.12 
contrainte 
restriction, limitation ou condition imposée à un système, qui trouve son origine à l'intérieur ou à l'extérieur 
dudit système 

[ISO 19439:2006] 

3.1.13 
langage de modélisation basé sur des constructs 
ensemble de constructs et de règles pour regroupements valides, définissant la syntaxe du langage de 
modélisation 

3.1.14 
label de construct 
chaîne littérale définie pour chaque canevas de construct et indiquant son type 

3.1.15 
canevas de construct 
structure commune qui permet l'identification et la description de constructs particuliers pour langage de 
modélisation et la désignation de leurs propriétés 

3.1.16 
règle déclarative 
ensemble d'objectifs et de contraintes combinés avec un ensemble de conditions non traitables 
informatiquement 

NOTE Des règles déclaratives peuvent être imposées à des «Business Processes» à l'intérieur de «Domains». 

3.1.17 
«Decision Centre» (Centre de Décision) 
〈modélisation d'entreprise〉 construct qui représente un ensemble d'activités de prise de décision dont les 
caractéristiques sont d'avoir le même horizon temporel, la même période de planification et d'appartenir au 
même type de catégorie fonctionnelle 

NOTE La terminologie utilisée pour décrire les aspects d'un «Decision Centre» se trouve dans 
l'ISO 15704:2000/Amd.1:2005, Annexe C, qui définit l'horizon (temporel) comme «la part du futur prise en compte par une 
décision, par exemple l'horizon est de six mois quand une décision est prise sur un intervalle de six mois» et la période 
(de planification) comme «le temps qui passe entre le moment où une décision est prise et celui où elle doit être ré-
évaluée». 
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3.1.18 
définition du déclassement 
phase d'un modèle d'entreprise qui définit, pour un domaine d'entreprise particulier, l'état final d'un système 
opérationnel déclassé, celui de tous ses composants ainsi que les processus utilisés pour conduire ce 
déclassement permettant ainsi leur réutilisation ou leur abandon 

[ISO 19439:2006] 

3.1.19 
dérivation 
〈modélisation d'entreprise〉 processus d'élaboration de modèles d'entreprise à des phases successives du 
modèle d'entreprise à partir des modèles établis lors de phases précédentes, en réutilisant les contenus 
disponibles et en les enrichissant en accord avec les besoins exprimés pour cette phase particulière de 
modèle 

3.1.20 
spécification conceptuelle 
phase d'un modèle d'entreprise spécifiant les «Business Processes» en même temps que les «Capabilities» 
et les règles qui doivent être exécutées pour répondre aux exigences 

NOTE Adapté de l'ISO 19439:2006. 

3.1.21 
«Domain» (Domaine) 
〈modélisation d'entreprise〉 construct qui représente la portion à modéliser d'une entreprise et fournit le moyen 
d'identifier les informations pertinentes 

3.1.22 
identification de domaine 
phase d'un modèle d'entreprise qui identifie le domaine d'entreprise à modéliser par rapport à ses objectifs 
métier, ainsi que les entrées et sorties de ce domaine d'entreprise avec leurs origines et destinations 
respectives 

NOTE Adapté de l'ISO 19439:2006. 

3.1.23 
exploitation de domaine 
phase d'un modèle d'entreprise englobant l'utilisation opérationnelle du modèle de domaine 

NOTE Adapté de l'ISO 19439:2006. 

3.1.24 
activité d'entreprise 
〈généralité〉 tout ou partie du plus bas niveau d'une fonctionnalité de processus exigée par les objectifs 
utilisateurs et qui est constituée des opérations fonctionnelles réalisées dans une entreprise en consommant 
des entrées, en allouant du temps et des ressources pour produire des sorties 

NOTE Adapté de l'ISO 19439:2006. 

3.1.25 
«Enterprise Activity» (Activité d'Entreprise) 
〈modélisation d'entreprise〉 construct qui représente une certaine partie du plus bas niveau d'une 
fonctionnalité d'entreprise, telle que requise par les objectifs utilisateurs et qui identifie les entrées 
nécessaires et les sorties créées en tant que résultat 
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3.1.26 
domaine d'entreprise 
partie de l'entreprise considérée comme pertinente pour un ensemble donné d'objectifs métiers et de 
contraintes et pour laquelle il y a lieu de créer un modèle d'entreprise 

NOTE Dans la présente Norme internationale, domaine d'entreprise est abrégé en «domaine» chaque fois qu'il est 
utilisé en tant que qualifiant dans des termes tels que «phase d'identification de domaine» et «modèle de domaine». Les 
autres utilisations de «domaine» ont la signification habituelle du dictionnaire. 

3.1.27 
modèle d'entreprise 
abstraction qui représente des entités d'entreprise, leurs interrelations, leurs décompositions et raffinements 
au niveau nécessaire pour véhiculer ce que l'entreprise projette d'accomplir et comment elle opère 

NOTE Adapté de l'ISO 19439:2006. 

3.1.28 
phase d'un modèle d'entreprise 
phase du cycle de vie d'un modèle d'entreprise 

[ISO 19439:2006] 

3.1.29 
vue de modèle d'entreprise 
vue de modèle 
perception ou représentation sélective d'un modèle d'entreprise accentuant certains aspects particuliers et 
négligeant les autres 

[ISO 19439:2006] 

3.1.30 
«Enterprise Object» (Objet d'entreprise) 
〈modélisation d'entreprise〉 construct qui représente un élément d'information de l'entreprise, cet élément 
d'information décrivant une entité générique, réelle ou abstraite qui peut être conceptualisée comme un tout 

NOTE 1 L'utilisation d'«Enterprise Object» est limitée au cas où seuls les aspects informationnels de l'entité concernée 
sont pertinents. 

NOTE 2 Tous les autres constructs dans la présente Norme internationale représentent des entités qui ont une 
sémantique spécifique requérant des attributs et des descriptions particulières. 

NOTE 3 Adapté de l'ISO 19439:2006. 

3.1.31 
«Enterprise Object View» (Vue d'Objet d'Entreprise) 
«Object View» (Vue d'Objet) 
〈modélisation d'entreprise〉 construct qui représente une collection d'attributs d'un «Enterprise Object» dans 
une perspective particulière 

NOTE La collection est définie par une sélection d'attributs et éventuellement de contraintes sur ces attributs. 

3.1.32 
entité 
toute chose concrète ou abstraite dans le domaine considéré 

[ISO 19439:2006] 
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3.1.33 
«Event» (Événement) 
〈modélisation d'entreprise〉 construct qui représente un fait, sollicité ou non, indiquant un changement d'état 
dans l'entreprise ou son environnement 

NOTE Un événement peut être associé à un «Object View» contenant des informations reliées à l'«Event». 

3.1.34 
vue fonctionnelle 
vue de modèle d'entreprise qui permet la représentation et la modification des processus de l'entreprise, de 
leurs fonctionnalités, de leur comportement, de leurs entrées et de leurs sorties 

[ISO 19439:2006] 

3.1.35 
«Functional Entity» (Entité Fonctionnelle) 
〈modélisation d'entreprise〉 construct qui est une spécialisation du construct «Resource» et qui est une 
agrégation de «Resources» et «Operational Roles» capable, de lui-même, d'exécuter en entier une (classe 
de) exploitation(s) fonctionnelle(s) requise par une «Enterprise Activity» et de communiquer avec le système 
de contrôle correspondant 

NOTE Une caractéristique d'une entité fonctionnelle est son aptitude à recevoir, traiter, mémoriser et envoyer une 
information. 

3.1.36 
catégorie fonctionnelle 
groupement d'entités pour l'expression d'un propos ou d'une aptitude commune 

3.1.37 
exploitation fonctionnelle 
unité de travail élémentaire et plus bas niveau de granularité dans la vue fonctionnelle 

NOTE Des exploitations fonctionnelles sont identifiées dans la phase de spécification conceptuelle, dérivant de la 
décomposition des aptitudes requises d'une «Enterprise Activity» (la tâche) en sous-tâches qui peuvent alors être reliées 
aux aptitudes proposées grâce aux «Functional Entities» affectées. 

3.1.38 
généralisation 
concept spécifique modifié, dans le but de lui donner une extension, un usage ou un but plus général, ou acte 
consistant à supprimer ou modifier des détails d'un concept spécifique pour arriver à sa généralisation 

NOTE 1 La généralisation est l'inverse de la spécialisation. 

NOTE 2 Adapté de l'ISO 19439:2006. 

3.1.39 
niveau générique 
collection de constructs génériques pour langage de modélisation utilisée pour exprimer des descriptions qui 
peuvent être utilisées pour générer des modèles aux niveaux partiels et particuliers 

[ISO 19439:2006] 

3.1.40 
description d'implémentation 
phase d'un modèle d'entreprise qui décrit le jeu final de processus, de ressources et de règles mises en 
oeuvre pour atteindre les performances d'exploitation désirées pour l'exécution des «Business Processes» et 
«Enterprise Activities» spécifiées dans la phase de spécification conceptuelle 

[ISO 19439:2006] 
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3.1.41 
composant de technologie de l'information 
composant exigé pour prendre en compte un ou plusieurs des éléments suivants: la collection, le traitement, 
la distribution, la mémorisation ou la vérification de données pour des «Enterprise Activities» de l'entreprise 

NOTE Adapté de l'ISO 19439:2006. 

3.1.42 
vue informationnelle 
vue de modèle d'entreprise qui permet la représentation et la modification des informations d'entreprise telles 
qu'identifiées dans la vue fonctionnelle 

NOTE 1 Elle est organisée comme une structure contenant des objets d'entreprise qui représentent les entités 
relatives à l'information de l'entreprise (matériel et information). 

NOTE 2 Adapté de l'ISO 19439:2006. 

3.1.43 
instanciation 
création d'instances de constructs pour langage de modélisation ou modèles partiels ainsi que l'assignation 
éventuelle de valeurs à certains attributs ou à tous 

NOTE Un construct pour langage de modélisation ou un modèle totalement instancié est un construct ou un modèle 
pour lequel des valeurs ont été assignées à tous les attributs. 

[ISO 19439:2006] 

3.1.44 
intégrer 
assurer entre toutes les entités d'une entreprise l'interaction nécessaire pour atteindre un objectif donné dans 
un environnement contraint, donné 

NOTE L'intégration est le résultat de cette méthode. 

3.1.45 
règle d'intégrité 
durant la phase de définition des exigences, instruction concernant les restrictions informationnelles destinées 
à assurer la conformité à la réalité du monde tangible 

NOTE Des règles d'intégrité sont utilisées pour définir ces restrictions en termes de contraintes sur des attributs 
d'«Enterprise Objects». 

3.1.46 
cycle de vie 
ensemble de phases distinctes et d'étapes à l'intérieur de phases qu'une entité traverse depuis sa création 
jusqu'à ce qu'elle cesse d'exister 

[ISO 19439:2006] 

3.1.47 
phase de cycle de vie 
stade de développement dans le cycle de vie d'une entité 

NOTE Adapté de l'ISO 19439:2006. 
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3.1.48 
composant de technologie de fabrication 
composant requis pour entreprendre une ou plusieurs des actions suivantes: le contrôle, la transformation, le 
transport, l'entreposage ou la vérification de matières premières, de pièces, de (sous) assemblages et de 
produits finis 

NOTE Adapté de l'ISO 19439:2006. 

3.1.49 
modèle 
description abstraite de la réalité sous quelque forme (y compris mathématique, physique, symbolique, 
graphique ou descriptive) présentant certains aspects de cette réalité 

NOTE Adapté de l'ISO 19439:2006. 

3.1.50 
construct pour langage de modélisation 
construct 
partie textuelle ou graphique d'un langage de modélisation échafaudé pour représenter, de manière ordonnée, 
les diverses informations sur les éléments et les propriétés communes d'une collection d'entités d'entreprise 

NOTE Adapté de l'ISO 19439:2006. 

3.1.51 
objectif 
énonciation d'une préférence au sujet d'éventuelles situations futures qui peuvent être atteintes, cette 
préférence influençant le choix entre certains comportements 

[ISO 19439:2006] 

3.1.52 
occurrence 
〈modélisation d'entreprise〉 concrétisation effective et unique d'un construct pour langage de modélisation, 
celle-ci représentant une entité particulière dans le monde tangible, au moment où le modèle est exécuté 

3.1.53 
«Operational Role» (Rôle Opérationnel) 
〈modélisation d'entreprise〉 construct représentant les compétences et les responsabilités humaines adaptées 
à celles des exigences qui sont requises pour accomplir les tâches opérationnelles qui lui sont assignées 

3.1.54 
«Order» (Commande) 
〈modélisation d'entreprise〉 construct qui est une spécialisation du construct «Enterprise Object» et qui 
représente les informations destinées à la planification et au contrôle de Business Processes dans une 
entreprise 

NOTE Un «Order» peut être représenté par un «Object View» qui est associé à un «Event». 

3.1.55 
«Organizational Role» (Rôle Organisationnel) 
〈modélisation d'entreprise〉 construct qui représente, à l'intérieur d'une structure hiérarchique donnée d'une 
entreprise, les responsabilités et compétences humaines adaptées aux exigences requises pour accomplir les 
tâches organisationnelles qui lui sont assignées 
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3.1.56 
«Organizational Unit» (Unité Organisationnelle) 
〈modélisation d'entreprise〉 construct qui représente une entité de la structure organisationnelle d'une 
entreprise et qui est décrit par des attributs de l'organisation ainsi que par des références aux entités 
organisationnelles du niveau inférieur et du niveau supérieur 

NOTE Des exemples d'«Organizational Unit» peuvent être un département ou une division. 

3.1.57 
vue organisationnelle 
vue de modèle d'entreprise qui permet la représentation et la modification de la structure organisationnelle et 
décisionnelle de l'entreprise ainsi que des responsabilités et de l'autorité des unités d'organisation et des 
personnes à l'intérieur de l'entreprise 

NOTE Adapté de l'ISO 19439:2006. 

3.1.58 
niveau partiel 
collection de modèles partiels 

[ISO 19439:2006] 

3.1.59 
modèle partiel 
modèle utilisé comme modèle de référence dans un type d'industrie ou dans une activité industrielle 
spécifique 

NOTE 1 Un modèle partiel est formé de constructs pour langage de modélisation ou d'autres modèles partiels. Des 
modèles partiels permettent aussi au modéliseur de réutiliser des modèles existants déjà et construits pour d'autres 
domaines. 

NOTE 2 Adapté de l'ISO 19439:2006. 

3.1.60 
niveau particulier 
niveau auquel un modèle est décrit pour un domaine particulier et spécifique d'une entreprise 

[ISO 19439:2006] 

3.1.61 
particularisation 
processus de spécialisation et d'instanciation par lequel des composants de modèles plus spécifiques 
peuvent être dérivés de composants plus génériques 

[ISO 19439:2006] 

3.1.62 
indicateur de performance 
métrique ou mesure par laquelle peut être évalué le fait qu'un objectif est atteint 

3.1.63 
«Person Profile» (Profil de Personne) 
〈modélisation d'entreprise〉 construct qui représente un ensemble de responsabilités et de compétences 
personnelles et qui sont demandées par un «Organizational Unit» ou une «Enterprise Activity» ou les deux, et 
sont mises à disposition par une personne 

NOTE Un «Person Profiles» peut être attribué à plus d'une personne et réciproquement une personne peut 
correspondre à plus d'un «Person Profile» pour plus d'une «Organizational Unit» ou «Enterprise Activity». 
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